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Micro Focus Visual COBOL 7.0 for Eclipse
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any updates to the documentation which might have been uploaded.

Visual COBOL is the industry leading solution for COBOL application development and deployment on
Windows, UNIX and Linux systems. Visual COBOL offers smart editing and debugging, enabling
developers to manage complex problems easier and faster than before.

Visual COBOL for Eclipse enables you to:

• Develop COBOL applications within the Eclipse IDE
• Deploy COBOL applications across a wide range of enterprise platforms including Windows, UNIX,

Linux, and JVM

Visual COBOL for Eclipse can be used with an optional add-on, Visual COBOL Development Hub, that
enables developers to centrally store source code and application artefacts as well as debug their
applications remotely on UNIX from their local Eclipse environment. This makes fault detection and
correction easier, enabling higher quality standards for application development efforts.

This product Help includes information about how to use Visual COBOL for Eclipse for local development
as well as for remote development using the Visual COBOL Development Hub.

Upgrading from earlier Micro Focus products

Note: Windows-only.

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.
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What's New
Enhancements are available in the following areas:

• Micro Focus COBOL Extension for Visual Studio Code on page 6
• .NET Core Support
• Application Workflow Manager
• COBOL Language Enhancements
• Code Analysis
• Code Set Support
• Compiler Directives
• Database Access - OpenESQL
• Data File Tools
• Developing Applications on Remote Machines
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• Library Routines
• Licensing Technologies
• Micro Focus Unit Testing Framework
• Platform Support

Micro Focus COBOL Extension for Visual Studio Code
Back to Top

The new Micro Focus COBOL extension for Visual Studio Code is available on the Microsoft Visual Studio
Marketplace. This provides edit, compile and debug support for Visual COBOL and Enterprise Developer
users in Visual Studio Code.

Note: The new Micro Focus COBOL extension is not included with the Visual COBOL installer.

.NET Core Support
Back to Top

Support has been added for creating, building and running .NET Core projects using the dotnet command.

This functionality is available in the following products:

• Visual COBOL for Eclipse

Application Workflow Manager
Back to Top

Improvements have been made in the following areas:
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• Modelling support for tool process logic under an action:

• You can now model loops and conditional execution of tools under an action, making the modeling of
complex tool logic under an action easier and more transparent.

• Icon support:

• Icons can be specified to consist of several layers which, for example, enables you to model icons
with decorators. The decorators can be displayed depending on conditions.

• Additional icons have been added to AWM.
• You can now specify and use your own icons.
• You can now specify icons for filter definitions.

• Filter definitions view:

• You can now export and import filter definitions to and from another workspace.
• The filter definition view's structure has been changed to a tree design enabling you to group

corresponding filters.
• "Micro Focus z/Server" connection type:

• Now supports drag & drop of a data set from the connection to an enterprise server instance's
catalog entry.

• You can now compress a z/OS PDS data set.
• New Micro Focus DevHub connection type function package:

• Provides a tool to send commands to a Micro Focus DevHub connection and receive the output
returned by the command so that it can be processed by other tools.

COBOL Language
Back to Top

The following enhancements have been made to the Micro Focus COBOL language:

• JVM COBOL data type to hold strings of utf-8 characters - support is now available in JVM COBOL
for the PIC U data type. This was already available for native COBOL, to support its introduction by IBM
in Enterprise COBOL version 6.3.

• The DYNAMIC LENGTH clause, which enables a data item to vary in length at run time, is supported.
Again, this is in response to its introduction by IBM in Enterprise COBOL version 6.3.

• The following date-format-checking intrinsic functions have been added: TEST-DATE-YYYYMMDD and
TEST-DAY-YYYYDDD.

Code Analysis
Back to Top

This release includes the following enhancements:

• Get Direct References command - you can use this command to see if changing a file will affect the
other files in your project as well as the files in the whole application. In Eclipse, you can access this
from the context menu or from the Analysis Server Explorer.

• Import points of interest - the Code Analysis view now includes a new button,  (Import points of
interest).
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Code Set Support
Back to Top

The following enhancements have been made to the integrated code set translation support:

• Arabic support for Enterprise Server applications is available.

If you are building Arabic support into Enterprise Server applications, your terminal emulator must
support the Arabic EBCDIC 420 code page.

Support is added by building your applications and configuring your enterprise server regions with the
MFCODESET variable set to the supported country code (0420). Your product's in-built code set
translation utility performs translations between the ASCII 1256 Arabic code page on your enterprise
server region, and a terminal emulator that supports the Arabic EBCDIC 420 code page (for example,
IBM's Personal Communications emulator).

There are some considerations when working with a bi-directional language such as Arabic.

Compiler Directives
Back to Top

The following Compiler directives are new in this release:

• PANVALET-INCLUDES-IN-COMMENTS - This directive controls whether ++INCLUDE statements in
comments are actioned or not.

• EXECSQL-FLAG - This directive defines whether syntax reporting should emulate that of the DB2
preprocessor, the DB2 coprocessor, or to allow all syntax variations of both.

• RM-FILE-ERRORS - This directive generates run-time system errors for certain file conditions, even
when a FILE STATUS clause is present; this is to emulate RM/COBOL behavior.

The following Compiler directive option has been deprecated:

• ILCLR(2) - this is as a result of deprecating support for versions 3.0 and 3.5 of the .NET Framework.
Applications that have this option set will produce an E level message when compiled in this release of
Visual COBOL.

Database Access - OpenESQL
Back to Top

This release provides the following enhancement:

• New OpenESQL TRACELEVEL=5 option - native OpenESQL applications can now trace ODBC calls to
the database vendor’s ODBC driver, recording the start and stop times of each call’s execution.
OpenESQL tracing can now provide more detail on where an SQL application is spending execution
time, in the OpenESQL layer or the underlying ODBC driver layer.

Data File Tools
Back to Top

This release includes the following enhancements in the Data File Editor:
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• New Data Explorer for working with data sets - a new Data Explorer enables you to connect to either
an ESCWA service or directly to an enterprise server region to access a catalog when working with data
sets in the editor.

• Multiple record selection- you can select multiple records and, where appropriate, can perform certain
actions on more than one record at once.

• Cut, copy, and paste functionality - traditional cut, copy, and paste functionality (including the
standard Ctrl+X, Ctrl+C, and Ctrl+V shortcuts) is now available throughout the editor.

• New filter creation - a new process for creating filters has been introduced. A filter consists of one or
more sets of conditions, and the resulting filter can include or exclude those records selected. The
previous filter process is still available, but has been marked as deprecated.

• Remote filtering - functionality has gone into Fileshare Server which allows filtering to occur server
side when opening data sets on remote enterprise server regions. The filter process results in only
those filtered records being downloaded to the data file editor client.

• Find/replace functionality - you can search records in a data file to identify specific strings, and then if
required, replace them.

Developing Applications on Remote Machines
Back to Top

Developing applications on remote machines with Eclipse has the following enhancements:

• New remote connection type: Micro Focus DevHub SSH Only - this new connection type utilizes the
built-in SSH daemon on the remote machine, and so very little configuration is needed from the Visual
COBOL Development Hub point of view (that is, there is no reliance on the RDO daemon/servers). This
option can also relieve the burden on using an X Server implementation when running/debugging
remote projects, as the 'SSH only' connection type can direct program output to the IDE's Console view.

• New remote connection diagnoses: firewall - the client-side and server-side connection diagnosis
reports now include enhanced details for potential firewall problems, for certain platforms (Red Hat 7.2
and later, CentOS 7.2 and later); see Remote connection troubleshooting. A new configuration file and
utility is also available to help with configuration/troubleshooting issues; see Configuring the firewall.

• Remote source files and debug symbol files - within a debug configuration for a remote project, you
can now specify source files and debug symbol files that reside on a remote host other than the one
containing the remote project.

Eclipse Integration
Back to Top

This release includes enhancements in the following areas:

• Supported Eclipse versions - this release supports Eclipse 4.16 (2020-06), which is shipped and
installed with Visual COBOL.

Versions of Eclipse prior to this one are not supported.
• Micro Focus Search - the search has been enhanced to filter results on the build action: in the Limit

To section, select Files configured for compilation to only include files in the search results that have
a build action set to Compile. The search results also include a new column, Build Action, that shows
the current action for each file.

• Formatting profiles - the formatting and clean up preferences for your COBOL code are now stored in
profiles. You can have many profiles per workspace, allowing you to easily switch between different sets
of formatting for different projects. The profiles can also be shared between local workspaces and to
other users, allowing developers to format code consistently throughout their team.

• The following new preferences have been added:
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• Force native line endings when pasting with Ctrl + Shift + V, available from Micro Focus >
COBOL > Editor: this option produces line endings native to the local operating system.

• Show Compiler directive summary in editor, available from Micro Focus > COBOL > Editor >
Compiler Directives summary: this option shows a summary of the Compiler directives in effect, in
the editor.

Enterprise Server
Back to Top

This release includes the following enhancements:
• Multiple Network Interface support - there is improved support for multiple network interfaces in some

components, including better awareness of network interfaces and control over networking. This is a
partial implementation and will be enhanced in future releases.

• Extended IPv6 support - support is available in Micro Focus Directory Server (MFDS) and in the Micro
Focus Communications Server (MFCS) listener for multiple IPv6 addresses.

In release 6.0, you could only configure MFDS and MFCS listeners to listen on a single IPv6 address. In
release 7.0, by default, MFDS and MFCS now listen on all configured IPv4 and IPv6 addresses, and
can also be configured to listen on a combination of specific addresses.

• HTTP improvements:
• Additional security measures for HTTP, such as security-related headers.
• Chunking support for large HTTP messages makes it possible to retrieve very large files from

Enterprise Server regions.
• Application Diagnostic Reporting for Enterprise Server - Application diagnostic reporting collects and

packages a number of reports, trace, and log files into a single report file.
• Enterprise Server now supports automatic reconnection to the standby Queue manager in an Multi-

Instance Queue Manager.
• The casmgr process has been optimized to improve the use of initiators when dispatching jobs across a

PAC. In addition, improvements have been made to the way it manages the queue of jobs waiting to be
dispatched.

• Information has been added describing the best practice and the recommended approach you should
adopt when performing a Patch Update to your PAC environment.

• (This feature has been added in 7.0 Patch Update 1) New operating modes , upgrade and quiesce,
have been introduced for Performance and Availability Clusters (PACs). These operating modes can be
used to facilitate the installation of product updates that introduce incompatibilities between PSOR data
structures. You can check for incompatibilities using the new caspac utility option CheckCompat. An
upgrade mode can be set when starting the first enterprise server region in a new PAC using the new
casstart utility start-type option u. This upgrade mode will prevent participating enterprise server regions
from processing batch workloads as part of its normal operation, and any EXEC CICS START requests
will be rejected. See casstart and caspac in your product Help for more information.

When enough enterprise server regions have been switched over to the new PAC, the old PAC can be
set to operate in the quiesce mode. This prevents further batch workload and EXEC CICS START from
being processed.

The new PAC can now be switched to running mode so that batch workload and EXEC CICS START
are enabled for processing again.

Note: Before setting the new PAC mode to running, you must switch enough enterprise server
regions to the new PAC to enable it to service the expected workload.

Enterprise Server Common Web Administration (ESCWA)
Back to Top
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This release offers the following improvements:

• MFDS User Interface functionality replacement - ESCWA now replaces the MFDS inside the IDE as the
engine that provides access to and management of regions. ESCWA provides all the functionality that
was previously available from MFDS. This release includes the following enhancements:

• Delete all regions.
• Session list.
• Renew listening addresses.

• ESMAC User Interface functionality replacement - the following ESMAC features have been
implemented in ESCWA:

• Resource Filtering.
• Millisecond support.
• Control the scope for all changes to timeouts, trace flags, and memory strategy when applied to

regions in a PAC.
• Enable Application Diagnostic reporting.
• Submission of local jobs from the JES Control page when CASRDO44_NEWSUB=OFF has been

specified.
• View and reply to pending ACCEPT FROM CONSOLE statements.
• The messages after a JCL job has been submitted are now correctly JSON formatted. This page

now works in ESCWA when MFJUXIT is enabled.
• Import, export, and copy regions - you can now use the UI to export and import regions in various

formats, including use JSON. You can:

• Copy regions between Directory Servers
• Import and export regions in JSON, XML or in the .dat legacy format. The legacy format can be

converted to a modern format.
• Mainframe Access (MFA) administration - ESCWA provides a modern Web UI and does not require you

to use a separate terminal application. Features include:

• Log in or off from MFA.
• Change your MFA password.
• View MFA server tasks.
• Retrieve the XDBOUT log (Web UI).
• Retrieve the JES spool files by DD Name (API).
• Set the MFA and JES tracing level.
• View the active MFA users.
• Invalidate active user sessions.
• View mainframe/MFA statistics.

The MFA API library has been exposed to enable you to test and use the requests that are provided.
• Scale-Out and PAC administration - you can now:

• Monitor Redis Sentinel and Cluster instances when used for Scale-Out Repositories.
• Specify that all changes to timeouts, trace flags, and memory strategy can be applied to one of three

options:

Only the local region.
All members of a PAC except the regions where local changes have been made.
All members of a PAC.

You can configure this in ESCWA with the Apply Scope field on the ES CONTROL page.
Alternatively, you can use the casutl utility with the /w option.

• Multi-Network Interface Card support - ESCWA now enables you to configure Communications Servers
and Listeners to listen on multiple IPv4 and IPv6 addresses. Previously, they were limited to listen on
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either all IPv4 addresses, or a single IPv4 or IPv6 address. Now a combination of any of the following
can be used:

• One or more specific IPv4 addresses.
• One or more specific IPv6 addresses.
• All IPv4 addresses.
• All IPv6 addresses.

• A new filter field resFilter has been added to the following ESCWA and ESMAC resource listing
modules:

Every resource in By Type
Every resource in By Start L
Resource lists under Groups
Every active resource type except Locks

This parameter will filter the list of resources displayed by ESCWA and ESMAC. In addition, a new
environment variable ES_RDO_MAX_RESOURCES has been added that enables you to specify a limit
to the number of records displayed. For JSON requests, the list being truncated is indicated by the
addition of the JSON property "truncated": true.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• MLDAP ESM caching - the MLDAP ESM Module now implements LDAP search-result caching. This is
controlled by the existing Security Manager cache settings, so that many installations will have this
activated automatically. See the product Help for details.

• Vault Hashicorp support - support is available for using a Hashicorp KV2 vault server as a local or
remote vault.

Library Routines
Back to Top

The following library routines are new:

• CBL_GET_ERROR_INFO - enables error processing routines to establish the location of the error that
occurred to cause the error processing routine to execute. This is available on a restricted range of
platforms.

• CBL_CREATE_STACKDUMP - generates a stackdump file.

Licensing
Back to Top

AutoPass licensing technology

In this release, Micro Focus brings in the power of the in-house Micro Focus AutoPass licensing
technology alongside Sentinel RMS. AutoPass has the following additional benefits compared to Sentinel
RMS:

• Usage logging which enables you to monitor the product usage. You need to install the AutoPass
License Server in order to do this.
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• Ongoing support for all platforms that this product is available for.

Features include:

• Installing this release installs both the AutoPass Daemon and the Sentinel RMS License Manager. Both
of them are available in the Micro Focus License Administration tool.

• You can have both AutoPass and Sentinel RMS licenses installed on the same machine. Optionally, you
can switch off the licensing technology you do not use.

• If you are an existing user of a Visual COBOL or an Enterprise Developer product, you only need an
AutoPass license if you want to utilize usage logging or if you want to use your product on a platform on
which Sentinel RMS is not supported.

• If you are a new user of the Micro Focus COBOL products, you will normally be issued an AutoPass
license.

• Micro Focus will continue to provide Sentinel RMS in future releases of this product.
• AutoPass licenses should be installed into the existing Micro Focus License Administration tool, and not

in the AutoPass License Server.

Installing licenses at the command line

On Windows, Micro Focus License Administration is now also available as a command-line utility.

For more about AutoPass and usage logging, and about Micro Focus License Administration, see
Managing Licenses in your product Help.

The Micro Focus Unit Testing Framework
Back to Top

The following enhancements have been made to the Micro Focus Unit Testing Framework:

• The MFUPP preprocessor has been introduced to provide a seam between your program and a unit
test. This seam lets you access the internals of a program under test, allowing you to create granular
unit tests from paragraphs or sections. The MFUPP preprocessor also provides the ability to mock
programs or stub programs out to create a unit test.

• In Eclipse, remote unit test projects for native COBOL can now be stored and run from Visual COBOL
Development Hub.

New Platform Support
Back to Top

Visual COBOL for Eclipse is now available for the following platforms, using AMD64 & Intel 64 architecture:

• Ubuntu Linux 20.04.x (LTS)
• CentOS 8.2

Visual COBOL Development Hub is now available on the following platforms:

• Red Hat Enterprise Linux 8.2 (and later) for IBM Z Systems.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

• Application Workflow Manager
• Common Communications Interface
• Compiler
• Data Tools
• Eclipse IDE
• Enterprise Server
• File Handling
• Header-to-COPY Utility
• Interface Mapping Toolkit
• Licensing requirements
• Reverse Debug and Live Recording
• Run-time System
• SQL: OpenESQL

Application Workflow Manager

Back to the list

• The checkout tool has been extend with the new input parameter "Resource Depth" which indicates
how the checkout will be performed. Allowed values are:

5 Infinite (all files and folders are check out recursively).
4 Immediate (direct files and empty folders are check out).
3 File (only files are check out).
2 Empty (the selected resource is check out without content).

See Checkout in your product Help for more information.

00486821 (71096)

• The ChangeMan attachment model now enables you to define job cards by a context menu action on
the application level. The action "Set Job Cards" is provided under the group "Quick ChangeMan
Access". If job cards are set, they are used in ChangeMan actions which submit a job, for example, the
build action.

(10698)
• There are now new import/export functions available in the filter definitions view. The import/export

functions are available as context menu and tool bar actions.

00371941 (13136)
• The Endevor attachment model now displays an error message when an attempt is made to open a

nonexistent element for editing.

3221338 (12418)

Common Communications Interface

Back to the list
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• The default TLS Security Level has been increased from 0 to 1. This change will not affect you if you
have specified your own security options.If you rely upon the default TLS security options you might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See Security Levels and Specifying a Server Protocol and Cipher Suite Preference in your product Help
for more information on the change to Security Level 1.

(8453)

Compiler

Back to the list

• Programs with file records greater than the documented limit of 62KB will now generate an error that
they previously did not (COBCH0649) - although being an E level message, the program can still be
executed and will work if it did so previously.

3227892 (12447)
• Two of the available Ant parameters for compiling COBOL programs have been renamed as follows

(functionality remains the same):

• forceCompile becomes mf.forceCompile
• threadCount becomes mf.buildThreadCount

3230709 (12665)

Data Tools

Back to the list

• The editor now automatically selects the first record in comparison when first loaded. The Editor will
automatically select first record in comparison when first loaded

3212848 (11362)
• Data File Tools now provides the Data Explorer, which is a catalog view that can connect to either

ESMAC or ESCWA. When connecting to ESCWA, it enables you to open multiple data sets.

(70242)
• The scrolling speed for formatted records has been increased.

00366018 (11378)

Eclipse IDE

Back to the list

• In Server Explorer, the "associate with project" option is not longer available for remote servers. Remote
servers are defined as any belonging to a remote directory server or remote ESCWA.

(57093)
• The Format Program option is no longer available for projectless files. Instead, select the Format option

and the text you want to format.

(8743)
• Customers using Eclipse on Windows who connect to a Development Hub on UNIX can now create

remote unit test projects. Remote unit test projects are available for native COBOL when you use a
Samba or RSE connection to the DevHub.

3164533 (13318)
• Within a debug configuration for a remote project, you can now specify source files and debug symbol

files that reside on remote hosts other than the one containing the remote project.

00363627 (12609)
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• When starting a server from Server Explorer, if that server is unsecured, you are not prompted to add
any credentials.

(62136)

Enterprise Server

Back to the list

• Previously, there was no security check performed when an ESMAC user tries to access the console,
traces, or dumps. This is no longer the case. If you use LDAP-based security you can now add the new
DIAGS resource under OPERCMDS class and provide access to ESMAC users accordingly.

3231918 (12556)
• The "Requested Licenses" field has been removed from the ESCWA General Properties page as it is

not used.

(3956)
• Added the option to delete the associated package when the service has an associated package and

that service is the only one with that associated package.

00370971 (22264)
• When a new region is created in ESCWA, the Web listener's conversation type is now correctly set to

"Web" instead of "SOAP and J2EE (legacy)".

3244594 (21270)
• The Group can now be specified when starting or stopping a region using ESCWA.

00371543 (12436)
• For Enterprise Developer 6.0 and later, the installer on Windows has automatically started the

Enterprise Server Common Web Administration (ESCWA) service as part of the installation process.
When using the Japanese system locale on the Windows operating system, the ESCWA service does
not start automatically. During the installation process you might be required to press Retry to complete
a successful product install. Even after a successful product install, ESCWA does not start until you
have installed a valid license.

00368527 (12747)
• In ESCWA, the Security Manager properties could be set too long, causing a crash. This has now been

fixed.

(61192)
• This fixes an issue with the change to the behavior introduced with the passtoken changes in previous

patch updates. An issue might occur in a stacked environment with OS ESM and MLDAP_ESM. Job
dispatch would issue a deny when cassub was used.

3229601 (11524)
• An issue when using a secured MFDS, with an LDAP ESM as first in the stack, and a PAM ESM as

second in the stack, and with federation enabled, has been resolved.Previously, if the security was
reinitialized through any means (such as clicking the apply button, or reordering the ESMs and
changing them back), the MLDAP ESM would not be able to correctly determine that the PAM ESM
user user1 in group1 matched the LDAP resource rule which described group1 within the resource rule.
This should have worked because the group information is shared when federation is enabled.With this
fix, the resource rule in LDAP correctly identifies that the group1 rule applies to the PAM ESM user
user1, on both initialization and reinitialization.Behaviour Change:When SAFMGR was reinitialized,
PAM ESM was pointing to the old shared groups table, so MLDAP ESM and PAM ESM ended up
pointing to different shared groups tables. It should have been the same table as federation was
enabled.PAM ESM groups table is now cleared on initialization, so that the ESMs will now point to the
same groups table.

3221760 (11697)
• ESMAC now includes cross-site request forgery protection. A 403 Forbidden page is now returned

whenever a user attempts to bypass the protection. If you want to access more than one region in
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ESMAC at the same time, it can no longer be done in the same browser session. You can access the
regions in separate private browsing sessions.

3216052 (13208)
• A new resource class, DCBINFO, enables you to control who can access the DCB information for

cataloged datasets in ESMAC for a LDAP secured region. DCBINFO must be created for existing users
to be able to access the DCB information in ESMAC.

3231918 (13300)
• We now take note of VALUE clauses for fields and properties defined in a JVM attribute (annotation),

and output the default value to the class file. When using an attribute, any field that does NOT have a
default value must now be specified explicitly.

(30021)
• MQ commands did not work because Windows installations of MQ are client, not server. This has been

ccorrected.

(46022)
• MFDS now correctly uses the specified region user in the ESCWA Directory Server Scripts page or

Directory Server user in the ESCWA Directory Server Configuration page. Otherwise, it defaults to the
current user.

(8727)
• If MFDS is set to "Restricted Access" and the MFDS "Anonymous access" option is off (the default),

then valid authorized credentials will be required to access information stored in the Directory Server
either via the legacy UI, ESCWA, or utilities such as mdump.

(62100)
• When MFDS is TLS enabled and a client connects on the non-TLS port, it will now send a HTTP 302

Found response to the client to redirect it from the non-TLS port to the TLS-enabled port. This is
seamless to the Web browser.

(46024)

File Handling

Back to the list

• Within MFDBFH, enhancements have been made to optimized I/O to further improve
performance.Enterprise Developer 6.0 and Enterprise Developer 7.0 only: The dbfhconfig utility has
been enhanced with the addition of the -optiokeyreads and -optioseqreads command-line options.
These options are used to override the default number of records read ahead by MFDBFH when
optimized I/O is enabled.

00726932 (83019)
• The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

3217597 (12477)
• A File Handler limit on the maximum record size (62KB) has resulted in the documented limits for data-

driven unit tests to be revised. See Restrictions in the Micro Focus Unit Testing Framework.

(25064)

Header-to-COPY Utility

Back to the list

• When h2cpy is used to convert C header files to COBOL copy files, function prototypes with const *,
which produce BY REFERENCE parameters in the ENTRY statement for the COBOL call prototype, will
now include the CONSTANT reserved word. In this context, it means the variable is read-only in the
callee, just like in C.

(10214)
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Interface Mapping Toolkit

Back to the list

• Headers are no longer mapped in the output of WS2LS.

3235120 (12606)
• Top-down CWS generation from WSDL now properly marks hexBinary fields in the generated WSBIND.

3236069 (11690)
• WS2LS now assigns usage COMP-3 to items mapped from decimal and integer types in the

WSDL.Behaviour Change:WS2LS will now assign usage COMP-3 to items mapped from decimal and
integer types in the WSDL. This will affect the generated copybooks and WSBIND. Previously-
generated files will still work, and users should be using the WSBIND and copybooks from a single
execution of WS2LS in their environment anyway, since changing one results in (or reflects) changes to
the other.

3235120 (13494)
• In copybooks generated by WS2LS, several data types now have mappings that are closer to those

generated by IBM's DFHWS2LS.Behaviour Change:In copybooks generated by ws2ls, several data
types will now have mappings closer to those generated by IBM's DFHWS2LS.

00365433 (11693)

Licensing requirements

Back to the list

• The following platforms - Solaris, Red Hat on IBM Z System, SUSE on IBM Z System, and Ubuntu - are
now licensed using a new licensing model called AutoPass. These platforms and licenses are not
available from the Software Licenses and Download portal (sld.microfocus.com) if you are using the
existing SafeNet license technology. To obtain AutoPass licenses for the aforementioned platforms,
contact your account manager to discuss your actual requirements, and also raise a support incident to
track the request.

Reverse Debug and Live Recording

Back to the list

• Reverse Debug and Live Recording functionality is licensed and installed separately from undo.io. From
this release forward, you can enable reverse debug functionality by downloading the extension from the 
Micro Focus Marketplace.

Run-time System

Back to the list

• When defining the file name for CBL_CREATE_STACKDUMP, %f now expands to basename of the
program correctly when used cross-process.

(60049)
• When CTF trace level is set to info (for post-offset values only) or debug (for pre-offset, offset and post-

offset values) and component rts#process is set to true, the API will now dump the captured metrics to
the output CTF file.

(27040)

SQL: OpenESQL

Back to the list

• An issue with compiling native programs that use SQL TYPE IS XML AS CLOB has been resolved.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• Oracle does not support deployed .NET Core 3.x client applications on SUSE Enterprise Linux
accessing Oracle databases.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in Visual COBOL 6.0.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

• Copying and pasting the contents of a license file into the License file field of Micro Focus License
Administration results in the error "The path is not of a legal form. Please contact Micro Focus
SupportLine".
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Application Workflow Manager
• CGI Support
• Code Analysis
• Common Communications Interface
• Compiler
• Data Tools
• Data Tools (Classic)
• Debugging
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• Interface Mapping Toolkit
• Java Artifacts
• Micro Focus Server Administrator (GUI)
• Setup Issues (UNIX)
• Setup Issues (Windows)
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• XML Support
• z/Server

Application Workflow Manager

Back to the list

• Using "Open In COBOL Copy View (F4)" in an MVS Explorer edit session and then closing one of the
editors caused both editors to be closed at once. This is now fixed.

00454015 (57131)
• SVN working copy tools now work on resources which have been marked to be deleted.

00369126 (21269)
• The default AWM system is now loaded on creation of a new workspace and displayed in the

Application Explorer view.Note: This means you can see all applications defined under the system, but
none of them will be loaded.

3234724 (11584)
• The MFA directory report now contains a flag which is set if the PDS is SCLM managed. This will

enable clients to issue a warning if users try to edit a member from the workstation.

00364682 (11579)
• Round bracket characters "()" in the parameters of the "Execute ISPF Command" tools will no longer

cause parser errors on the mainframe.

00366738 (12672)
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• Saving IDz resources is performed asynchronously. Before running the AWM Edit Save Action, AWM
had to wait for the IDz resource synchronization job to finish. A problem occurred because the IDz
resource synchronization job started later than the previous IDz releases. This has now been fixed.

3234392 (12592)
• A new optional "Custom Project Name" parameter has been added to the SVN "Checkout" tool.

00369125 (11699)
• Key sequence can now be modelled by a filter type for new filter creation.

00371082 (13312)
• You can now integrate your own icons into AWM. The icons must be provided in the AWM model by

adding them to the model icons category.

3120968 (13080)
• You can now specify a volume serial when creating new data sets under the MVS Explorer.

00371070 (12335)
• The "Print to Console" tool has been added to the Eclipse function package. See "Print to Console" in

your product Help for more information.

(10659)
• It is now possible to model an "Execute ISPF Command" tool in AWM which creates an entry in the

AWM Jobs view for a specified job ID. The tool must call the REXX procedure TAUTORJI.

3177843 (12262)
• Deletion of resource operations without an explicit element ID failed with a warning message. This is

now fixed.

(9771)
• The AWM tool Reparse with Refresh now clears cached copybooks which have been deleted on the

mainframe.

(10761)
• Copybooks and include files automatically downloaded during remote edit are now opened in read-only

mode.

00364684 (12531)
• The AWM function package tool "Locate File" returned a shared file descriptor instance, which was

causing trouble with multiple opened editor sessions. This is now fixed.

00371089 (13486)
• The AWM SVN function package now provides a link property reflecting the owner of an SVN lock.

3228755 (13304)
• AWM tools like "Create Structured File" or "Return Property Value" can now create table or JSON files

containing linked property values.

00371254 (12488)
• Certain characters, like the Euro symbol (€), were not displayed correctly in the MVS and JES explorer.

This is now fixed.

(41010)
• The resource operation "UPDATE" now works for the linked property in mass processing.

3236232 (11687)
• The "Retrieve" button for the AWM filter type "Micro Focus Project Folder Content" did not populate the

folder name field. This is now fixed.

00484518 (69029)
• The Rename Resource tool in the Eclipse function package is now correctly working with COBOL

Explorer.

00373331 (13560)
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• AWM used to only check the minimum length of mandatory properties.Now, non-mandatory properties
are also checked for minimum length.The minimum length of non-mandatory properties, however, is
only checked when the value of the property is not empty.

3239603 (12676)
• The Eclipse function package tool "Get Projects" now has the optional "Project Name" parameter. When

this parameter is specified, only project names matching the filter pattern will be returned by the tool.

3234110 (13360)
• In the event of the TAURTOCX COBOL Compiler exit failing because the source listing is too long, the

error message will no longer overwrite the compiler listing and the build will fail with an RC=8.

00364683 (11745)
• UPDATE resource operations with a specific AWM element ID and matchname now work if the target

element has not been revealed before.

3239602 (12740)
• The relative paths returned by the "Get Repository Items" SVN function package tool are now always

relative to the SVN repository root.

00374063 (11766)
• You can now specify multiple icons for AWM element types. Each icon acts as an image layer and can

have enabled conditions. This enables icon images to be dynamically composed at run time.

3120969 00370555 (12297)

CGI Support

Back to the list

• The query string for CGI Applications using REQUEST_METHOD=GET no longer has a limit of 4096
bytes.

3227061 (10285)

Code Analysis

Back to the list

• A problem that caused the exclusion of the SQLCA copybook has been fixed.

3219870 (11398)
• This release supports nested COBOL programs in a single source module.

00366795 (12647)
• Verification errors for a specific structure-based slice have been fixed.

3236246 (13377)

Common Communications Interface

Back to the list

• A problem that caused the ccierr.log to contain multiple "connect_endpoint(), called in NET_CONNECT,
return code 2" messages has been fixed.

(77040)
• When running an application that uses CCI in an aggressively multi-threaded environment, RTS 114

errors could be generated.

00370924 (13510)
• Because of a previous optimization that was made it might result in getting stuck on a blocking receive.

This has been fixed.
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00457870 (57287)
• Enterprise Server for UNIX and COBOL Server for UNIX now include the same Run-Time System and

CCI C header files that are available in Enterprise Developer Unix Components and in Visual COBOL
Development Hub.

3230929 (13552)
• An integer overflow in CCI time handling has been fixed.

(9632)
• When running an application that uses CCI in an aggressively multi-threaded environment, RTS 114

errors could be generated.

00370924 (12575)
• A rare crash in the Micro Focus Communications Server under heavy load has been resolved.

3238018 (11727)

Compiler

Back to the list

• A large amount of REPLACE text no longer causes unexpected syntax errors.

00483050 (66002)
• The precision of intermediate results, and hence the result of arithmetic expressions, has been modified

when ARITH(COMPAT) is specified to emulate the equivalent IBM option.

00373696 (12616)
• CALL <data name>, where data name is defined as an ANY LENGTH item, now works as expected.

00365007 (13541)
• A missing period on a File Description entry now compiles with only a warning message under OSVS

emulation.

3227505 (11445)
• A JSON GENERATE statement on a structure containing variable length groups now compiles and

executes as expected.

00429712 (57257)
• When specifying a subscript, it is possible to use 'index-name +/- data-name' when under an MF dialect.

00371309 (13582)
• Within the Eclipse IDE, hovering over a data item which is part of an arithmetic expression, now shows

the correct content of that item.

00506208 (69314)
• EXEC INCLUDE syntax with a period following the include name (and before the END-EXEC) is now

supported for better compatibility with the Oracle Pro*COBOL precompiler.

00370456 (12738)
• Very long source lines now debug as expected.

00481396 (65050)
• A new directive RM-FILE-ERRORS is provided to control emulation of RM/COBOL file errors. See the

documentation for full details.

00368536 (12711)
• READ and WRITE statements under DIALECT"RM" now only process the exception clause appropriate

for the format of that statement.

00368537 (12729)
• DISPLAY literal AT now works with the DISPLAY-AT directive.

3201040 (12639)
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• A bug has been fixed so EA now indicates if a nested program is "COMMON".

00366795 (70003)
• There is no longer an issue in printing the value of the EXITPROGRAM directive when SETTING is on.

00369139 (12490)
• FUNCTION DISPLAY-OF(nat-var, 1208), which is a national data item to UTF-8, no longer truncates the

UTF-8 results.

(8864)
• Compiling a program containing nested date intrinsic functions with the compiler option

INTDATE(LILIAN) now produces valid object code as expected.

3227569 (12457)
• The CONSTANT qualifier can now be applied to data items > PIC 9(18).

(8678)
• A DISPLAY of sub-screen-section items that are under a group LINE identifier clause now position

correctly.

00368541 (13573)
• A new Compiler directive, DPC-IN-DATA, enables you to control whether the DECIMAL-POINT IS

COMMA clause (if specified) is applied to the output from the XML GENERATE and JSON GENERATE
statements.

3225204 (12393)
• The record area of a print file is no longer cleared after a WRITE statement for a program compiled with

a mainframe dialect.

00383677 (47029)
• Within the Eclipse IDE, hovering over a data item which is part of an arithmetic expression, now shows

the correct content of that item in the tooltip.

00491644 (69551)
• The NOBOUND directive specified after the SSRANGE option is now correctly respected. Also, when

both NOBOUND and SSRANGE are specified, the behaviors of the intermediate and generated code
are now consistent.

3226804 (12430)
• ISO2002 behavior for PROCEDURE DIVISION/CALL RETURNING is now under ISO2002(2) to allow

compatibility with Server Express/Net Express. The previous behavior can be selected with ISO2002(1).

00363117 (12604)
• The startup time of the run-time system has been reduced, which has resulted in improved compilation

performance for some programs.

00384452 (50019)
• The $REGION syntax can now be used in comments if the DIRECTIVES-IN-COMMENTS directive is

specified.

3232251 (12464)
• The SCREEN SECTION clause FROM ZERO no longer produces an internal error.

00380019 (31075)
• Index names within a COBOL program no longer cause validation issues when compiling for use with

EA.

00370455 (28197)
• When a large numeric data item (with more than 18 decimal digits) was used as a parameter to a

method expecting a java.lang.Long object, bad code was generated, which resulted in a run-time error.
This is now fixed.

00370452 (28056)
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• When multiple programs are compiled concurrently, it is possible that two compilation units attempt to
create the same Ref type (generated as containers for reference parameters) at the same time,
resulting in file locked errors. A fix has been made that means if such an implicit class already exists, an
attempt to recreate it is not made, and the compilation proceeds normally.

(60005)
• When compiling for JVM, if the parameter list for a procedural COBOL program includes a long numeric

passed by value, followed by a group item passed by reference, and the program is compiled with the
ILSMARTLINKAGE directive, incorrect code was generated for the extra typed method. This is now
fixed.

00371913 (27057)
• When debugging generated code, if the first statement following PROCEDURE DIVISION or an ENTRY

statement is a GO TO statement, stepping into that program could fail and the debugger would zoom.
This has now been fixed.

00455393 (69101)
• For native generated code, a bug when referencing a field in a linkage section parameter when

PROTECT-LINKAGE has been specified has been fixed.

00479164 (71154)
• For Intel x86 32-bit generated code only, a bug in generating code with OPT"4" set, which caused the

Compiler to hang, has been fixed.

00619916 (71454)
• A run-time system error (COBRT114), which occurred at generate time when a call literal contained an

unmatched quote symbol (that is, '"'), has been fixed.

3242461 (13524)
• Support is now available for the Control-M function %%$WEEKDAY. Control-M week day variables now

correctly respect the start week day specified in mfbsi.cfg (StartOfWeek=Sunday|Monday).

(10495)
• In Control-M emulation, a problem that prevented the $WCALC function from accepting a variable for

the calendar name has been fixed.

00487802 (69090)
• The Control-M XML Calendar has been updated to enable the defining of 366 days, even for years

other than leap years.

00488291 (71104)
• The Control-M SUBSTR function now correctly handles the Start and Length variables defined using

environment variables.

3226645 (11688)
• In a non PAC environment, MFBSI now validates that the .sem files created in $MFBSI_DIR use

STRIPSPACE=ON.

3224140 (11417)
• An abend 0C4 sometimes occurred when mfbsijcl was cancelled from a scheduler. This has been

resolved by returning an abend S222 instead.

00366666 (12724)
• The mfbsi.cfg file now supports a new parameter, STDNUM, which is set to ON by default. If

STDNUM=OFF, aLL JCL records in columns 73-80 are ignored even if there are JCL statements or any
in-stream data records in these columns. The previous MFBSI logic based on the contents of the first
record of JCL and whether it contains any data in columns 73-80 is maintained. This parameter is
mainly useful when your JCL members contain a mix of STD NUM ON and OFF. for existing customers

3230289 (12654)
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Data Tools

Back to the list

• A 'large file' alert is no longer displayed when opening files > 128 MB and the 'Use temporary file for
editing' option is not selected.

(69199)
• The Column indicator in the status bar now shows the correct value when selecting a field in the right-

hand pane (structured view).

00491656 (70177)
• An issue which could cause the Data File Editor to hang the region has been fixed.

00426198 (58053)
• The Data File Editor now provides navigation to the last page when showing fixed-block, variable-block,

and indexed files, and also for filtered results. If Go To <record-number> is also larger than the number
of records available, the last page of records is displayed, instead of a "no record found" error returned.
For sequential fixed-block files, the available number of records is also shown.

(88030)
• The ruler will now stay at the top of the displayed record list, even when you scroll down the page.

00485504 (71308)
• The performance of the Data File Tools catalog has been enhanced when using a database-hosted

catalog file, and when specifying a data set name filter with a leading wildcard character.

00377995 (31059)

Data Tools (Classic)

Back to the list

• The Data File Editor now support temporary changes to sequential, line-sequential, and relative data
files. Users can choose to save those changes to the data file, or revert the changes, leaving the data
file in its original state. See 'Editing Data Files' in the documentation for more details.

3239290 (12680)

Debugging

Back to the list

• An issue has been fixed where an RTS 114 error was thrown when attempting to run Animator (ANIM)
on a large core-dump file (approx 4.5GB+) in 64bit mode.

00454504 (57137)
• Watchpoint values now update correctly when they change when using the x64 configuration.

3235325 (13441)

Dockerfiles

Back to the list

• The HEALTHCHECK in the Dockerfile for the CICS container demonstration on Windows sometimes
failed to run.

(8146)
• On Ubuntu, in order for debugging to work within a Docker version 18.04 Container, you must update

the kernel of the Docker host from version 5.0.0-27 to 5.0.0-31.

(9295)

Resolved Issues | 27



Documentation

Back to the list

• The Comments section of the ListWidth directive documentation now clarifies behavior that only
happens under SOURCEFORMAT"FIXED".

00382245 (30116)
• The documentation has been updated to reference the ACUCOMMENT directive correctly (previously

referenced with a hyphen - ACU-COMMENT).

(58226)
• The documented IDE equivalents for the run-time tunables have been updated to reflect the current IDE

options.

(7279)
• The Configuring Your Application... tutorial, for converting RM/COBOL applications in the IDE, has been

updated, as some RM/COBOL-specific configuration files are no longer shipped with the product.

00365052 (7877)
• The syntax rules have been updated in the documentation in regards to the order in which the

OCCURS and VALUE clauses can be specified for a data item; see syntax rule #2 of the 'Data
Description Entry Skeleton' topic.

(8710)
• The documentation has been updated to correctly state that up to 1024 conditional expressions are

possible within the INCLUDE and OMIT program control statements of a SORT operation.

3232114 (12450)
• A definition for the environment variable MFRU_NOINHERIT has been added to the documentation

(Windows-based only).

3145619 (13073)
• The documentation has been updated with details of how to use CSSID translation tables in deployed

applications; see Codeset Translation for more information.

(8567)
• The product Help has been modified to indicate that you can only use analyzer programs if they have

been compiled with ASCII or EBCDIC specified as the character set. See "Analyzer Programs" in your
product Help for more information.

3231967 (12460)
• The documentation has clarified the values acceptable for the SORTCOMPRESS environment variable:

to enable SORTCOMPRESS, specify any positive integer.

3228239 (13280)
• If a build is producing java.lang.OutOfMemoryError errors, you can try increasing the amount of

memory available to the heap. Increase the maximum amount allowed by using the -Xmx parameter in
the cobjvm.cfg file.

00367351 (13272)
• The documentation has been updated to include a known restriction where the cobcall function does

not locate statically-linked COBOL programs on Windows platforms.

(8304)
• Documentation updated to highlight a difference in behavior when using CBL_DIR_SCAN_READ for

native COBOL, on a UNIX platform: the '.' and '..' directories are not returned if bit 1 of the search-
attribute is set for CBL_DIR_SCAN_START; whereas, for JVM COBOL, those entries are returned.

(9557)
• The documentation for the dbfhdeploy command has been updated to list all possible file types that can

be added using this command.
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(9566)
• The documentation has now clarified the use of the MFCODESET values AUTO and DEFAULT,

particularly for Japanese Windows, and UNIX platforms.

3229004 (13290)
• The Message Files section of the National Locale Support documentation has been corrected to use

the .msg extension for user-created message files.

(8387)
• The documentation for the dbfhdeploy command has been updated with a reminder to escape any

semicolons with a backslash on UNIX platforms.

(9565)
• A recommendation has been added to the documentation for the tunables DATEWARP_DYNAMIC and

TIMEWARP_DYNAMIC. It is recommended that these are not used in an Enterprise Server
environment.

3235487 (13455)
• If the ILSMARTLINKAGE directive is used, and a linkage record contains a data item that cannot be

uniquely qualified, then no property is generated for that item and a warning (COBCH1969) is
produced.

00371909 (11629)
• The documentation for CBL_SPLIT_FILENAME has been updated to ensure that the syntax diagram

and the definitions are consistent.

(10599)
• The documentation has been corrected to state that the SORT environment variable for determining

where the run-time system stores paging files is called TMPDIR (not TEMPDIR).

(9534)
• The MFDAS AWM command has been added to the MFDAS topic. See MFDAS AWM API in your

product Help for more information.

(9474)
• The restriction documented for multi-preprocessor usage has been updated to state that it is supported

for native COBOL, and for JVM COBOL that uses the 'dynamic calls' feature.

3234218 (12614)
• The documentation for the CBL_ALLOC_* and CBL_FREE_* library routines now state the limitation of

using those routines in sub-programs that have the AMODE directive in effect.

(10712)
• The Server for COBOL 5.1 for UNIX product have been made available at https://

supportline.microfocus.com/Documentation/books/es51sx02/espubb.htm?
_ga=2.88126877.763212273.1598017839-160368923.1595923556

00370782 (13509)
• You can now configure and optimize database connections using options in your MFDBFH configuration

file (mfdbfh.cfg). See Optimizing Database Connections in your product Help for more information.

00367278 (12752)
• The directive lists automatically set for certain language-related directives have been updated to

remove obsolete directives.

3223241 (12411)
• The PC_PRINTER_LOAD_BMP documentation has been updated with the list of supported formats

that may be used with this routine.

3111670 (8680)
• The Unit Testing Framework documentation now updated to advise against manually editing test fixture

files. Instruction on how they are to be managed is given in the topic 'Test Fixture Files'.
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(10585)
• The software requirements have been updated to indicate that the 32-bit gcc libraries are not required

for Red Hat 7 and Red Hat 8.

3222619 (12400)
• The 'Using Breakpoints and Watchpoints' topic has been updated to include more detailed information

on breakpoints.

(8289)
• A JVM COBOL tutorial has been reintroduced to the documentation: 'Tutorial: Packaging JVM COBOL'

covers how to package JVM COBOL applications as JAR files.

(9247)
• The list of available samples, as noted in the documentation topic 'Demonstrations of COBOL', has

been updated to include:- OESQL - Shared Connection COBOL to Java (JVM)- OESQL - Shared
Connection Java to COBOL (JVM)

(8803)
• The documentation for deploying JVM COBOL applications has been updated to include a number of

files that are required depending on the content of your COBOL. You must include:

• mfidmr.jar if the application uses JSON PARSE syntax
• mfsqljvm.jar if the application uses SQL syntax
• mfle3790.jar if the application uses any LE Callable Services APIs

00367560 (27058)
• See "Additional Software Requirements for PACs" in your product Help for more information on

software support and compatibility for Performance and Availability Clusters (PACs).

00367289 (13588)
• One of the parameters in the example given in 'Create Microsoft SQL Server Datastores Using Script

Files' has been corrected. It now reads -password:<pass>, and not -password=<pass>

(71177)
• The documentation now states that the iFileshare functionality has been deprecated. It also

recommends the alternative solution for anyone that was relying on iFileshare.

00367322 (22266)
• The EJB Service Interface tutorial has been updated to state the need to create a 32-bit project, in order

for it to work with the 32-bit enterprise server region that is utilized later in the tutorial.

(26287)
• If you are using Java 11 for any JVM COBOL tutorials, additional prompts may appear relating to Java

modularization; these can be ignored for the purposes of the tutorials.

(57507)
• The MFUnit tutorial in Eclipse (Tutorial: Running Unit Tests in the IDE) has been slightly updated with

regards to screenshots matching the program names created in the instructions.

(61245)

Eclipse IDE

Back to the list

• When dealing with standalone files, the .idy files available during debug are now also used when
parsing the standalone files.

00369039 (11715)
• An issue that prevented you from connecting with Server Explorer if credentials had been cleared has

been fixed.

(9467)
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• The "COBCH0766S Failed to create class file" error is no longer reported when a project is built by
using multiple concurrent compilations/links.

(60007)
• The COBCH0766S Failed to create class file error is no longer reported when a project is built by using

multiple concurrent compilations/links.

(60006)
• A performance issue when using the cursor keys or Page up/down keys in the editor has been fixed.

00373503 (13616)
• An issue with the AWM 'Get Servers' tool incorrectly returning an empty list has been fixed.

00480399 (66053)
• When the "Use dynamic calls" option is enabled, files that have a build action of "Ignore" are now

correctly ignored during a build.

00367558 (11730)
• JVM COBOL source that is part of a linked resource can now be compiled as a single file.

3236418 (12723)
• When launching a server check via the 'Diagnose connection problems' option, additional information is

now displayed if timeouts are exceeded.

00373492 (11752)
• After the JSON GENERATE statement is executed, the Variables view is populated with the expected

variables.

00378392 (31044)
• During a connection diagnostics check, an issue with locating the xterm executable through an ssh

connection when there is a MOTD (message of the day) on the remote machine has been fixed.

00373492 (12657)
• Error checking in the Diagnose Remote Connections process has improved in respect of checking for

write access errors.

00373492 (13420)
• The Server Explorer view now contains a filter option (similar to the one in COBOL Explorer view) that

enables you to filter the servers displayed in the view.

00371167 (11483)
• An issue when updating a file and then saving the changes while comparing 2 COBOL files in Compare

mode has been resolved.

00457183 (58116)
• The Micro Focus search has been enhanced with a new 'Limit to files configured for compilation' option.

Select this option to remove all files that have a Build Action set to Ignore from the search results.The
Results pane has a new 'Build Action' column, which can be used to sort files based on their Build
Action.

00371168 (13301)
• An issue was identified when generating web service information and the CHARSET directive for a file

was not set to the default for the specified COBOL dialect. This has been resolved.

00725150 (73147)
• Edit/Browse dataset member menu items are now available on multi-line DSN statements.

3229382 (13308)
• mffilelist elements inside COBOL build files can now be nested. See the mffilelist reference topic in the

Micro Focus Ant User Manual for more information and examples.

3232287 (13594)
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• In the Micro Focus Build preferences pane, the "Each part of the package name corresponds to a
subdirectory" option has been renamed to "Package to subdirectory matching". Its functionality remains
unchanged.

(6945)
• Japanese translations in various property pages within Eclipse have been corrected.

(10518)
• An issue was identified in the generation of dependency information when projects were placed in paths

of certain lengths. This has been resolved.

3231446 (13440)
• Support for nested programs in the Program Flow view has now been implemented, and will now

correctly display the graph for a nested program when invoked from the Outline views or the COBOL
editor.

00366795 (71348)
• An issue was identified when using code slicing features with Samba remote projects, in that the path to

the analysis information was not being correctly calculated. This has now been fixed.

3232148 (13311)
• The startrdoserver and startrdodaemon scripts now use the value of $TMPDIR (if set) as their

temporary variable location. Additionally, these scripts now do a better job of cleaning up temporary files
in non-error cases.

00374074 (12702)
• When performing a column-based text search in the COBOL editor, the end column specified was not

included in the search (so specifying a search between columns 1-6 would actually only look in columns
1-5). This has been fixed so that the specified end column is included in the search.

00375087 (30042)
• In Eclipse, a new option has been added to the editor preferences, Force native line endings...), which

when selected, causes any code pasted into a COBOL editor using the Ctrl+Shift+V key combination to
be inserted using line endings appropriate to the local operating system.

00375702 (57254)
• When traversing child variables of a parent, in order to find their memory addresses, operation did not

always stop when a child was found; Instead, it was continuing through all children. Therefore, in some
cases, when an array and its DEPENDING ON variable happened to be in the same memory block, the
result was an infinite loop of calls, and hence a stack overflow occurred. Now, the loop is stopped when
the proper variable is found.

3236284 (13446)
• A new preference has been added to allow all Micro Focus source file editors in Eclipse to be opened in

overwrite mode instead of the (default) insert mode. Select Window > Preferences > Micro Focus >
General > Editor > open Micro Focus editors...

00371258 (13454)
• An issue with file-level settings when the source file was included via a linked folder located within a

subfolder of the project has been fixed; however, you may be required the to delete the .cobolBuild file
from the project, to force it to be regenerated.

00371255 (13503)
• The Eclipse preprocessor sample readme now correctly displays within the Samples Browser.

00373585 (11558)

Enterprise Server

Back to the list
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• HTTP 403 restrictions no longer erroneously prevent access to ESCWA and ESMAC after interacting
with the MONITOR > Monitor page in ESCWA and ESMAC.

(57283)
• Configuring a region to have 47 Service Execution Processes resulted in the console daemon failing to

start on DBCS platforms. This has been fixed.

00371935 (13365)
• An EJB-wrapped COBOL service involving multiple invocations would not always commit database

changes until the dispose event was driven. This resulted in updates not being accessible while the
service was in-flight. This has been fixed.

00367387 (13507)
• Using the AMODE option to request a reload of a data table using the CPMT transaction sometimes

resulted in a FUNC abend. This has been fixed.

00726248 (77027)
• An issue with the FAULTCODESTR parameter on the SOAPFAULT CREATE API has now been

resolved.

3232615 (11548)
• The Enterprise Server utility program casclsec did not work correctly on non-Windows platforms. This

has been fixed.

00365438 00375691 (12562)
• The output from caslock is no longer truncated at 64k.

00368510 00477856 (11573)
• A message is now displayed in the console.log file when Enterprise Server fails to create a process

when starting a region.

3222161 (11434)
• Fixed parameter processing when the -x option is specified with casstop. Information about the -x

option has been added to the command line help for casstop and casstart. See casstop and casstart in
your product Help for more information.

(26323)
• HTTP Headers processing now supports HTTP Headers that do not have any spaces between ':' and

the value.

3232451 (12434)
• A truncation of custom messages occurring in HSF has been fixed.

00382022 (39011)
• On WEB RECEIVE and WEB SEND, if you omit all of the code page conversion options

(SERVERCONV, CLNTCODEPAGE, CHARACTERSET, HOSTCODEPAGE), no code page conversion
will take place.

3232480 (11632)
• When a CWI analyzer program was not returning a converter or a server program, an "EIBRESP 27

pgm not found" message was returned. Enterprise Server now correctly returns the static response
received from the analyzer.

00367285 (28199)
• The dfhcbtct.cpy copybook is now provided with the product.

(25040)
• A change to an internal synchronization procedure resulted an increase in the time taken for a DELAY

to respond to a CANCEL from 20ms to 100ms. This has been fixed.

3236122 (12619)
• An issue with multiple header processing programs in the pipeline has been fixed.
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3225239 (11464)
• HSF records had a response time of 0 when the application executed EXEC SQL statements and there

were no trace flags switched on. This has been fixed.

00367263 00383874 (23073)
• If ES_ESM_XUSER=NO, Enterprise Server still performs a check for the surrogate user to be defined in

the system but does not check for the surrogate authority.

3231824 (13335)
• In the case of the SEP monitor thread performing a soft kill, CAS will now defer freeing shared memory

blocks (ICE and ACPE) associated with task DCA until end-of-task processing in the main thread.

(29002)
• Enterprise Server now enables automatic reconnection to the standby Queue manager in an Multi-

Instance Queue Manager. See "Reconnecting to an MQ Server in a Multi-instance Queue Manager" in
your product Help for more information.

00367275 (13387)
• An issue where the Syncpoint option of MQ PUT and GET APIs was set to "NO_SYNCPOINT" has

been fixed.

3241185 (11747)
• When using MQBACK in JCL the messages were not rolled back if the user had not specified mqpmo-

syncpoint when the message was stored using MQPUT or MQPUT1. This has now been fixed.

00725720 (69586)
• Intermittent I/O errors (typically reported with a 9/13 file status) occurred during file creation when using

DB2 datastores.

(9767)
• An RTS 114 no longer occurs in CASSTORE during concurrent SET-FILE / RELEASE PROGRAM

statements.

3240785 (12742)
• Ensure that for protected starts the recoverable flag is set on the TST entry that is cached on the TCA

TST chain.

00367517 (53093)
• An issue existed with importing and/or exporting a (long) SIT fileshare username and password with

casrdtup or casrdtex. Lower-case characters are no longer converted to upper case, and the fileshare
username and password are now correctly displayed in both ESMAC and ESCWA.

00371939 (23050)
• A new filter field "resFilter" has been added to the following ESMAC resource listing modules:

• Every resource in by Type
• Every resource in by Start L
• Resource lists under groups
• Every active resource type except Locks

This parameter will filter the list of resources returned and displayed by ESCWA and/or ESMAC. This
will avoid excessive response buffers being sent over the network which might degrade browser
performance. In addition, a new environment variable ES_RDO_MAX_RESOURCES has been added.
This enables you to specify a limit to the number of records ESCWA and/or ESMAC will attempt to
display. For JSON requests the list being truncated will be indicated by the addition of the JSON
property "truncated": true.

00367293 (13581)
• The stack size of cassi.exe has been increased from the default 1Mb to 2Mb.

3232744 (13324)
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• CICS-MQ Bridge functionality is now available as a Technical Preview. It supports CICS target DPL
applications that interact either with a COMMAREA or CONTAINER interface.

00363634 (11447)
• On UNIX platforms, under certain circumstances the request to start a process was incorrectly reported

as having failed. This has been fixed.

00696684 (82001)
• A trace that was not controlled is now emitted when the trace API flag is enabled.

3231371 (11628)
• Default users were not added to HSF. This has now been fixed.

00376906 (31028)
• Enabling ESLOGGING for the Oracle Switch resulted in an error. This has been fixed.

(46056)
• XA switch now handles CAS xa-flow correctly to resolve in-doubt transaction issues on connection loss.

00368472 (48018)
• XA switch now handles CAS xa-flow correctly to resolve in-doubt transaction issues on connection loss.

00368472 (48018)
• The XA Switch module now tries to reuse an existing connection in order to prevent multiple

connections being opened for the same XA resource within the same process.

3239642 (13477)
• The DB2 XA switch module now works with DB2 applications that are compiled with the NOPRE

directive option.

3237650 (11691)
• The ES_XA_%xaname%_OPTIONS environment variable can attempt to reconnect up to a maximum

of 9999 times.

00455239 (59135)
• A new exit for ESXACUSTOMORA has been added to the Oracle switch module. The build scripts have

also been updated with some new options to enable this logic.

00367295 (20268)
• The XA Switch module now handles the Duplicated Connection error correctly.

3211450 (11427)
• The Vault module is no longer unloaded after the first transaction.

3243323 (12584)
• The SQL cursor is now kept opened when CICS SYNCPOINT is executed if the cursor type is WITH-

HOLD or the SQL compiler directive option CLOSE_ON_COMMIT=NO is specified.

00364548 (11684)
• The DB2 XA Switch module now sets the Package Path correctly.

00362931 (12718)
• The Micro Focus Directory Server security configuration custom text could not be set or modified from

the Enterprise Server Common Web Administration (ESCWA) HTML GUI interface or API.

(9646)
• ESCWA can now set region listener endpoint values that contain a valid hostname as well as an IP

address value.

(10258)
• When creating a new Communications Server for a region the "autostart" value was incorrectly set. This

has been fixed.

(71033)

Resolved Issues | 35



• MFDS now supports the HTTP Strict-Transport-Security (HSTS) response header in responses from its
TLS-secured endpoint.

00368444 (11617)
• Changing the configuration of a running region no longer causes the region to change to 'Not

Responding' status.

00620712 (70308)
• You can now establish new MFDS sessions even if the maximum number of concurrent sessions is

reached. A minimum number of UI administration sessions will always be retained.

3240043 (13428)
• An issues with the MFDS service not starting if the MFCESD licensing daemon was not started has

been resolved.

3228431 (12644)
• The Micro Focus Directory Server HTML GUI now includes an additional XSS protection.

3243314 (13537)
• Previously, a low-privileged user (without read permissions to a region) could manipulate URLs to get

read access to that region's Server properties, listeners, services, packages and handlers. This
information leakage has now been fixed, and in these case the user will now see a 403.

00368584 (11392)
• Region import will no longer fail if the mfServerNonDefaultSecurityConfiguration node is missing.

00696539 (69402)
• Exporting the MFDS Journal when using a 64bit MFDS process could cause a crash. This has now

been fixed.

(9735)
• MFDS no longer errors when eight Security Managers are configured to be stacked for use by the

MFDS process. Eight stacked Security Managers is the maximum permitted.

3232694 (12528)
• When a malformed request was sent to MFDS it could become unresponsive. This has been fixed.

00445311 (58026)
• Fixed a regression causing incorrect files to be output from an MFDS Web UI export.

(86058)
• When using MFDS via a web browser or connecting to it via mldap (with MDUMP for instance) it was

possible that MFDS would not respond immediately. This has now been fixed.

(57189)
• If a user or user group has a "Read" allow but no "Update" allow ACE for the "Enterprise Server

Administration" class "Options" resource, then they will be able to view but not update the MFDS
options values. Previously only the "Update" rule allowed a user to view MFDS options.

3217327 (12380)
• MFDS binary repository exports (non-XML exports) in Visual COBOL and Enterprise Developer 6.0

could contain listener data that was not cross compatible if imported on certain UNIX platforms that did
not create the exports.

(61176)
• MFDS now sends the "Secure" cookie attribute if MFDS has been configured to use TLS.

3228919 (11606)
• If the MFDS process has been restarted or you have clicked its "Renew" option, client applications such

as Server Explorer inside the IDE and ESCWA will now automatically reestablish a connection.

(10516)
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• When using startup and shutdown scripts in MFDS, when run for a second time it would result in a
permission error when writing the script out to a file. This has now been fixed by keeping a backup of
the existing script and by writing the new one out again.

00377287 (30073)
• A potential double free caused by a race condition involving the exit handler has been fixed.

3242625 (11709)
• MFDS became unresponsive when performing multiple simultaneous service deployments. This has

been fixed.

00739041 (87099)
• When you perform an XML export or import of regions with multiple communication processes, the

communication process autostart option value is now correctly preserved.

3236278 (11644)
• When using the region name option (/f) with casclsec, the option was not passed to the utilities invoked.

This has now been fixed.

00696227 (73045)
• MFFTP creates an end-of-line (eol) file when the file transferred from Enterprise Server is a Variable

Block (VB) file. A new environment variable (MFFTP_DISABLE_EOL=Y) enables the VB file to be
transferred from the Enterprise Server environment as it is. The default value is 'N'.

00477620 (57488)
• An issue with a SEP been killed and stuck in termination has been fixed.

00675262 (69370)
• When the External Security Facility in Enterprise Server has the auditing option enabled, with the syslog

auditing option, some processes could accumulate multiple connections to the syslog server.

00374548 (12564)
• Enterprise Server can optionally cache the results of user signon (ESF Verify) requests in order to

improve the performance of signon operations. Caching these requests from any mainframe-emulation
environments now works properly when enabled in the security configuration.

3232724 (11516)
• In some cases, portions of the configuration text of an Enterprise Server External Security Facility

configuration were not processed correctly. This has been fixed.

(58016)
• The Enterprise Server ESF Admin LISTUSER command has a new optional parameter which disables

locking the group list while computing a user's group membership. See the documentation for
LISTUSER in your product Help for more information.

3235237 (11586)
• Enterprise Server ESF Update requests no longer report an error if a Security Manager does not

recognize a user or group being updated.

00383391 (32087)
• When Enterprise Server Externals security is used with both PAM and LDAP external security

managers, and all-groups, federation, and PAM groups are enabled, the PAM groups are correctly
added to the user's group membership when the PAM ESM is not the first ESM in the list.

3221760 (11538)
• When Enterprise Server External Security is configured with both a PAM security manager (pam_esm)

and an LDAP security manager (mldap_esm), and all-groups mode and group federation are enabled,
and the PAM security manager is configured for PAM group processing, the various ESF Update
operations (update user, update group, update all) will now correctly update the user group membership
information from both security managers.

(8088)
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• The Enterprise Server External Security Facility's Update feature could sometimes cause a SEP to
abend with a COBOL RTS 114 error. This has been fixed.

00384962 (47011)
• The Update All button was not refreshing the group permissions for a name mapped user in an LDAP

ESM. This has been fixed.

00364056 (11765)
• Arabic support for Enterprise Server applications is available as part of the in-built code set support. If

you are building Arabic support into Enterprise Server applications, your terminal emulator must support
the Arabic EBCDIC 420 code page. Support is added by building your applications and configuring your
enterprise server regions with the MFCODESET variable set to the supported country code (0420).
Your product's in-built code set translation utility performs translations between the ASCII 1256 Arabic
code page on your enterprise server region, and a terminal emulator that supports the Arabic EBCDIC
420 code page (for example, IBM's Personal Communications emulator).

00374780 (11480)
• If a deployed application does not require a full Enterprise Server product to be available, but also relies

on the inbuilt DBCS translation support, those applications must be deployed with the appropriate code
set mapping files, and then you must use the MFCODESET_DBCSDIR environment variable to locate
those files at run time. See 'Codeset Translation' in the product documentation for more details.

(10286)
• Access to the ESMAC pages are now verified and validated server side when applicable. A disabled

button client side could be re-enabled and used to access an unauthorized page. This has been fixed.

00368464 (12713)
• Enterprise Server will now issue a physical cancel to ESMAC modules even if CAS_SRV_CANCEL is

set to a non-default value.

3245515 (27055)
• Redundant comments in the source code have been removed.

3239529 (12691)
• Cookie validation has been improved to prevent any unauthorized tampering with the casCookie.

00368456 (11740)
• Creating an Active MQ Listener failed. This is now fixed.

(69437)
• Changing the status of a listener through ESCWA no longer times out on UNIX.

(71113)
• Enterprise Server External Security passtokens and the DCAS (Digital Certificate Authentication

Service) feature now work properly when using a security configuration with two or more Security
Managers of different types.

3231876 (11549)
• The Enterprise Server DCAS feature has been enhanced to work with IBM HATS.

00431373 (57050)
• Handling sessions for the Micro Focus Binary Protocol has been enhanced in the Micro Focus

Communications Server. This resolves a number of long-standing issues where sessions could be
leaked or misused by misbehaving clients. It affects J2EE services hosted by Enterprise Server and
possibly some other uses of the MFBINP protocol.

00367384 (12716)
• Language specific decimal separators are now dealt with by the MFCS and by extension ESCWA

components when outputting JSON.

00502140 (69256)
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• Enterprise Server's esfupdate utility now supports updating servers where the Communications Process
control listener is configured for TLS (SSL).

3236811 (11615)
• In Enterprise Server, performance and capacity have been improved when retrieving large files, such as

server log files and spool output, over the Internet.

00370973 (12381)
• The following headers on the responses for the multiprotocol listener (often named "Web Services and

J2EE") have been added:- X-Frame-Options- X-XSS-Protection- X-Content-Type-Options- Content-
Security-Policy This includes ESMAC responses.Header values:“X-Frame-Options": "SAMEORIGIN""X-
XSS-Protection": "1; mode=block"“X-Content-Type-Options": "nosniff"Content-Security-Policy": "default-
src http: https:; img-src 'self'; script-src 'unsafe-inline' 'self'; style-src 'unsafe-inline' 'self'; worker-src
'none'; object-src 'none'"

00367046 (13389)
• MfsecretsAPI no longer masks exit codes from COBOL applications.

(10521)
• Support for the Hashicorp vault is now available in the Secrets API.

00370908 (11321)
• The migrate command of Mfsecretsadmin now works when two separate configurations files are

specified.

00365440 (11662)
• When ESMAC CSRF handling was active, and the first request to ESMAC was a POST request, the

request failed because it had no CSRF token. To correct this, the ESCWA server now obtains a CSRF
token by making a GET /native/v1/regions/{host}/{port}/{region}/esproperties request before the POST.

(10570)
• A notification was incorrectly displayed when opening or closing a DCT. This has now been fixed.

00364218 (12601)
• The number of items than can be displayed in the ESCWA tree has been increased to 512.

(8765)
• An issue where it was not possible to set the Codeset on Catalog Entry DCBs in ESCWA has been

resolved.

(9706)
• Added a DOWNLOAD option to the ESCWA Journal page. See Journal in your product Help for more

information.

(57228)
• The STOP POLLING button has been added to the ESCWA Control page. This enables you to stop

polling for the region's status while starting and stopping a region.

Note: Clicking STOP POLLING will not stop the region form starting or stopping.

(6983)
• An issue with regions created in ESCWA not showing in the Web Service - Deployment Server list in

Eclipse has been resolved.

3234600 (13345)
• The ESCWA security page did not clearly identify that it was only for configuring ESCWA's security and

did not affect Directory Servers. The page now has the new title "ESCWA Security Facility
Configuration" as well as a new information alert to make this clear to users.

(9711)
• A problem translating names displayed on table filters to match their corresponding columns has been

fixed.
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(53076)
• ESCWA now creates the commonwebadmin.json file if it has been deleted rather than refusing to start.

You can use this to reset ESCWA back to a default state.

00367573 (13511)
• In ESCWA, you can now disable the logon screen animation. To do this, at the top right of the menu bar

click the user icon and then switch off Animate Logon.

00366659 (11795)
• ESMAC sent response and latency percent information to ESCWA which did not total 100%. In this

case, ESCWA was displaying the wrong information in its HSF detail charts. This has now been fixed.

00372430 (27158)
• The API documentation for ESCWA ESM requests has been updated.

(26197)
• ESCWA lost connection information for Directory Servers when the ESCWA session timed out. This has

been fixed.

(7891)
• Underlying issue causing the SSL authorize page to appear when navigating between listeners has

been fixed; the SSL authorize page now only appears when you click Authorize.

(8638)
• When using the ESCWA or MFDS Web APIs, a new session cookie is now attached to a failed API

response.

(9661)
• ESCWA now handles regions that are started correctly but it cannot contact if it has its listeners set to

connect on loopback only.

(51008)
• ESCWA now validates ports for /config APIs.

(8730)
• MFCC will now correctly parse IPv6 addresses when connecting.

(8498)
• Fixed segfault on the exit of the ESCWA shutdown command line option.

(69484)
• The new ESCWA copy region functionality enables you to copy or discard the port as required.

2795268 (11098)
• ESCWA will now generate an error and prevent changes being made to a Communications Process if

the region would no longer have a Communications Process set to auto start.

(62177)
• Control characters present in the console.log resulted in invalid JSON. The ESCWA server now

replaces these control characters with spaces.

(61254)
• The size of tables in ESCWA are now adjusted based on the number and height of the rows.

(10385)
• MFDS Logoff method has been implemented in the ESCWA API and Web UI.

(51041)
• Widgets on the ESCWA dashboard now display the name of the directory server as well as the region.

This enables you to differentiate where regions have the same name.

3225866 (13408)
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• The Enterprise Server MLDAP ESM module no longer leaks sockets when there are transient
connection or bind failures with the LDAP server.

00378150 (30089)

File Handling

Back to the list

• MFDBFH now correctly handles schema names that are specified more than once when updating the
CURRENT PACKAGE PATH. Previously, this was treated as an error causing the associated database
operation to fail.

00374750 (24079)
• Improvements have been made to MFDBFH to reconnect where possible when database connections

are lost.

3225946 (12378)
• The dbfhadmin command-line tool has been enhanced to allow PostgreSQL databases to be created

on a remote server, or a server using the non-default port 5432. A remote PostgreSQL server can now
be specified using the -host option, and an alternative port number can be specified using the -port
option. Previously the only way to use dbfhadmin to create remote PostgreSQL databases was by
setting the PGHOST and/or PGPORT environment variables prior to use. Alternatively, the PostgreSQL
psql command could have been used to directly execute the generated SQL script.

(71250)
• Configuration options have been introduced to restrict the lifetime of database connections. These

options are primarily for use with PostgreSQL to enable integration with connection poolers such as
pgbouncer and pgpool-II.

00367281 (24080)
• Newly-created ESDS files now support the full 32-bit ESDS key space. Existing ESDS files will remain

limited to 31 bits/half the space.

00367110 (12692)
• The Enterprise Server transaction performance has been improved.

3232506 (12506)
• An I/O error occurred during a file open operation when a Db2 SQL application was sharing the user

database with an MFDBFH datastore and had issued a "SET CURRENT PACKAGE PATH" command.
MFDBFH now automatically appends any schemas it needs to the current package path when required.

3214792 (12453)
• An RTS 114 error sometimes occurred if the CAS spool view was repeatedly refreshed while switching

between Active, Completed, etc.

(8805)
• A 9/21 error (file is directory) is now returned if an attempt is made to open a filename which has been

specified as a folder URL.

(9444)
• When returning a record read from a line-sequential file, MFDBFH did not pad the record with spaces.

This was incompatible with the EXTFH behavior for a disk file.

(10361)
• MFDBFH did not reconnect to PostgreSQL databases after losing connections.

(10205)
• An ESDS STARTBR specifying prev (or prev equals) with a RID of X"FFFFFFFF" was not correctly

starting the browse from the last record in the dataset.

00367110 (12555)
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• MFDBFH enhancements have been made to improve performance when components need to check for
the existence of database-hosted files.

00468750 00488011 (61239)
• MFDBFH no longer causes excessive CBL_THREAD_SLEEP API entry/exit events being output to

CTF trace files when RTS tracing is enabled.

3226855 (13319)
• MFDBFH has been enhanced to improve the recovery from a lost database connection, and other

transient errors, when creating a file.

(69520)
• MFDBFH now supports Oracle databases (version 19c and later).

00367287 (13426)
• MFDBFH no longer uses the default stack size associated with the main thread of the process when

creating its worker threads. This helps avoid receiving any RTS 114/115 errors at run-time due to
memory exhaustion if the user has specified a very large stack size to be associated with the main
thread.

00373754 (12548)
• Performance enhancements have been made for MFDBFH's handling of COBOL READ statements.

Part of these changes now installs an additional database index for each alternate key associated with
a file when the key is created. For files that have been created prior to this change, the "dbfhdeploy
upgrade" command has been enhanced to install all missing indexes for a given file.

00488011 (70352)
• The performance of the ESMAC Catalog View has been enhanced when using a database hosted

catalog file and when specifying a dataset name filter with a leading wildcard character.

3242217 (11705)
• An error message is now output when attempting to use dbfhadmin to generate a script file to a non-

existent folder, or to one without write permissions. Previously the operation either silently failed, or
resulted in an run-time system error 115.

(62236)
• The "dbfhadmin -region -list" command failed to list regions which were not associated with a database

of the same name. This problem could occur when a single physical database was used to host regions
and datastores. The problem is now fixed.

(30001)
• When an Enterprise Server instance has been configured to use database-hosted resource locks, the

ESMAC Locks view no longer remains in a busy state if the connection to the region and/or cross-
region database has been lost.

(51129)
• MFDBFH is automatically upgrading existing datastores to resolve some existing restrictions on the

maximum number of files that can be supported, and to prepare for future enhancements. Datastores
periodically need to be upgraded and should not impact the user in any way. However, in previous
versions of MFDBFH, if an upgrade did fail, it would do so silently and could only be detected by trace
files and/or unexpected application behavior. If an upgrade does fail, it is normally due to the client
connection having insufficient database privileges to perform the operation. This change now also
reports an upgrade failure to the user and give the user the opportunity to manually perform the
upgrade using the new "dbfhadmin -upgrade -datastore datatore-url" command. This command
generates an SQL command script, which should then be executed by a database user with sysadmin
privileges.

Note: For Enterprise Server scale-out systems using PostgreSQL datastores, you may want to
consider temporarily shutting down the system, applying the patch update on each of the scale-out
machines, and then restarting the system. This will avoid potential batch job failures that could
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occur on active scale-out machines that had not had the patch update applied due to them still
using cached older versions of procedures that have been replaced by the upgrade.

(58126)
• When using Microsoft SQL Server, WRITE operations no longer fail with a 3/0 status (I/O error) for files

using AUTOMATIC|MANUAL SINGLE record locking when a record lock is not held.

(58041)
• A temporary file that was being used by the rebuild utility had its file size restricted, which caused the

recovery of large files to fail; this has now been fixed.

00375739 (30033)
• A performance issue has been addressed that was affecting parallel compilation.

3230709 (12666)
• A stability issue has been resolved that was being caused by using SHARE-OUTDD in a batch setting.

00369363 (13336)
• A new Fileshare Server option is available to control the regularity in which the disk file checks are

carried out when the Flush on Commit (/fc) option is in effect. By default, the check occurs on every
flash, but by setting /fds <value> you can limit the number of times the check will be performed.
Permissible values are 1-65536. Any values < 1 is treated as 1, and any value > 65536 is treated as
65536.

00370974 (13238)
• FSMGR was not logging out all clients when instructed to.

3237032 (12656)
• Any temporary file created through Fileshare by Data File Tools will be deleted if Data File Tools

crashes or is disconnected.

(69512)

Interface Mapping Toolkit

Back to the list

• Generated clients that use InvokeService04 will now compile and run correctly on UNIX.

3233543 (13384)
• A problem that prevented JSON-REST Web services from using an application RETURN-CODE to set

the response HTTP status code has been fixed.

00369975 (11324)
• A problem that prevented JSON-REST Web services from using an application RETURN-CODE to set

the response HTTP status code has been fixed.

00370461 (11716)
• New service interfaces added to Enterprise Server Application projects are now in the correct format.

(10415)
• For ws2ls, unions are now mapped with their default whitespace behavior as collapsed.

3237304 (13437)
• For ws2ls, boolean data types in the WSDL are now defined as BOOLEAN in the generated WSBIND

file.

3237798 (12511)
• When returning the LDO array of all operations in a JSON service, any operation in the JSON response

with an empty "path" attribute is now returned with a "href" value of "/<operationName>".

(10411)
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• When data containing a null character is returned to a Java string, the null character is no longer used
as a delimiter and will instead be included in the Java string

00367385 (11622)
• A service created from an earlier non-versioned service definition now gives correct behavior on a

POST or PUT REST operation.

00372694 (13565)
• In a program that has two or more tables that are empty, the SEP would abend after deploying and

running the service in Enterprise Server. This problem has been resolved.

3229853 (11498)

Micro Focus Server Administrator (GUI)

Back to the list

• A potential MFDS abend in scenarios where a "Renew" is repeatedly issued and TLS is enabled has
been resolved.

00368581 (13379)
• A Content-Security-Policy has been added to all MF Directory Server HTTP response headers.

Additional restrictions on how MFDS process shutdown requests are handled.

00379021 (30103)
• Secured REDIS servers now automatically connect in secure mode.

3229330 (11499)

Setup Issues (UNIX)

Back to the list

• If MFDS is started and attempts to use a zero sized XML options file, instead of terminating with an
error it will write out the default options and continue to operate.

(53015)

Setup Issues (Windows)

Back to the list

• The cblms tool no longer detects Windows SDK installations that do not include the required lib
subfolder and so are not valid to use.

(8454)
• Spacey input paths are now handled correctly.

3236578 (11603)
• The topic "Installing Visual COBOL in an Offline Environment" in the product Help of Visual COBOL for

Visual Studio and Enterprise Developer for Visual Studio available from the Micro Focus SupportLine
now includes instructions about how to add CRL information into the certificate store. This is a required
step for offline installations that enables the validatation of the signature on the Visual Studio extensions
without any errors.

00378086 (51001)
• The Software Requirements topic in the product Help for installing on UNIX machines now includes

more detailed instructions about how to set up the LANG environment variable. This must be set before
you start the installation.

LANG must be set to one of the following English or Japanese locales: C, default, en_GB,
en_GB.UTF-8, en_US, en_US.UTF-8 ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp,
ja_JP.sjis, ja_JP.ujis, ja_JP.utf8, japanese
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Set LANG either before running the setup file - for example: export LANG=C Alternatively, add it at the
start of the command for running the setup file:LANG=C ./setup_...

00371216 (11458)
• The deployment SDK zip file names now include the Patch Update number and the build package

number. For example, for Patch Update 4, the name of the deployment SDK file for Visual COBOL is
now generated as:cs_60_pu04_268826_deployment_sdk.zip

3240181 (13554)
• Previously, there was an issue when uninstalling release 6.0 of Visual COBOL or Enterprise Developer

if IBM DB/2 was also installed. This is resolved in release 7.0.

00368460 (11643)

SQL: COBSQL

Back to the list

• Support in COBSQL for a large number of REDEFINE data items has been increased to up to 8000.

3244127 (13591)
• COBSQL did not correctly handle the byte conversion of FETCH statements with 10 COMP items and

one Non-COMP item. It now correctly handles this scenario, as well as the same one in INSERT
statements and EBCDIC conversion.

00365970 (22267)
• COBSQL now supports EBCDIC conversion in the case in which the operator token is right next to a

host variable inside a DECLARE SELECT statement.

3232492 (13562)
• COBSQL now handles correctly a long list of host variables when the KEEPCOMP Compiler directive is

used.

00365968 (13415)
• COBSQL now displays an error (in Visual Studio, Eclipse and on the command line) when the procobol

command is not found.

(10332)
• EBCDIC conversion when DECLARE TABLE statements are present is now handled correctly.

3236281 (12536)
• COBSQL now supports the EBCDIC conversion in the case in which the host variable used in a FETCH

statement was previously initialized, and the FETCH statement returns no rows.

3232429 (13368)
• A problem that caused COBSQL to abend with memory errors when the KEEPCOMP variable was

used along with certain array values in a "FOR :HOSTVAR ALLOCATE" statement has been corrected.
COBSQL now skips unnecessary byte conversions for "FOR :HOSTVAR ALLOCATE" statements.

00365886 (13607)
• COBSQL has been updated to handle redefined variable declarations broken into multiple lines.

00430595 00506991 (59202)
• COBSQL now supports EBCDIC conversion of saved declare cursor variables with '=: variable syntax'.

3240853 (13447)
• COBSQL has been updated to override or reset previously set directives with those specified by inline

$SET statements as needed.

00422020 (53080)
• COBSQL now supports host variables used in FOR :HOSTVAR statements when the KEEPCOMP

directive is used.

00373979 (11794)
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• COBSQL is no longer unnecessarily setting a "bad pointer" to check if the EBCDIC modules are
present.

3242687 (12748)
• COBSQL now supports EBCDIC conversion of redefined host variables.

3241688 (12700)

SQL: DB2 ECM

Back to the list

• DB2 ECM now correctly handles data item names with the character 'f' or 'F'. It also handles arrays of
COMP values correctly when the FOR n ROWS clause is used.

3229912 (13341)
• When DB2(RELEASE=COMMIT) was specified and the targeted database was not DB2 z/OS, the

compiler generated a warning indicating that the directive would be ignored. This has been corrected.

00371184 (11372)
• Using a group host variable with FILLER could cause a Visual Studio background parse crash of Visual

Studio. Compiling from the command line would result in a subscript out-of-range error. This issue has
been resolved.

00371048 (27157)
• A problem compiling a COBOL program using dialect ENTCOBOL on a program using ROWSET in a

SQL statement has been fixed.

00424387 (57057)
• An issue with the HCO for DB2 LUW tooling in DDL generation where creating a table with a "FOR

EACH" or "FOR BIT" clause on a column was generated incorrectly has been resolved.

00373396 (11400)
• DB2 ECM now handles COMP data items correctly when the NULL indicator array is involved and

COMP data item is used in the SQL Statement as both input and output host variable.

3236080 (12661)
• The HCO for DB2 DDL tool erroneously inserted a space when an input line filled the maximum column

with a non-space literal value, and continued on the following line at position 1. This has been fixed.

3205352 (8474)
• The limit on the NULL indicator array size has been extended from 255 to 1012.

00368494 (12545)
• A problem that caused a failure in the CheckSwitchUserStatus section when running a job that uses

DB2 User impersonation has been fixed.

00375618 (32025)

SQL: OpenESQL

Back to the list

• When compiling with the ILTARGET directive without specifying x86 or x64 bitness, an unknown type
'type OdbcWrapper.Class1' compiler error was returned erroneously. This has been corrected.

(52174)
• An error that occurred when a DB2 stored procedure was called from the ADO runtime has been

resolved.

00425931 (58056)
• Opened cursors are now kept open after a ROLLBACK if SQL directive option

CLOSE_ON_ROLLBACK=NO or BEHAVIOR=UNOPTIMIZED is specified.
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3238292 (11710)
• OpenESQL application now retrieves DBCS strings correctly from PostgreSQL database.

00369140 (28051)
• An issue that caused truncation of a dynamic SQL statement and that resulted in a runtime error, even

when the maximum length of an allowed statement had not been exceeded, has been corrected.

00454855 (58163)
• The OpenESQL directive option CLOSE_ON_COMMIT is now available to select from the project's

properties inside Visual Studio and Eclipse.

00364548 (11631)
• The OpenESQL run-time now handles Oracle passwords correctly.

3230203 (13545)
• A problem that prevented the OpenESQL preprocessor from recognizing the SQL Server OPTIMZE

FOR syntax has been fixed.

00465904 (57173)
• OpenESQL did not handle syntax checking for PostgreSQL when using VARBINARY type variables.

3239363 (13433)
• The new PICXBINARY SQL compiler directive option,enables COBOL and PL/I programs to use PIC

X(n) host variables to receive data from BINARY, VARBINARY, LONGVARBINARY columns in binary
format without changing source to use SQL TYPE BINARY host variables.

3242422 (12745)
• .NET COBOL applications with dynamic SQL statements using SQLDA now work correctly via the

ODBC driver.

00370895 (11701)

XML Support

Back to the list

• The XMLIO run-time system now correctly handles namespace prefixes specified in the IDENTIFIED
BY clause.

00371218 (11634)
• The XML PARSE run-time system can now handle large elements content.

3222846 (13461)

z/Server

Back to the list

• Exits required for compiling COBOL via AWM modelling are now shipped in the product.

(24076)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• 00367244 (12615)
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Unsupported Functionality
This section includes information about features or functionality that are not supported.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Additional Software Requirements
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software.

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care.
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Installation

Supported Third Party Software
The table below lists some of the software requirements and Third Party Software this product is tested
with.

For full details on the supported software, see Software Requirements and Additional Software
Requirements in this product's install notes.

Software Requirements

Integrated Development Environment Eclipse 4.8 - installed with Visual COBOL.

Eclipse 4.7 is also supported.*

Java 64-bit Java 8 is required for running Eclipse

Java 8 (32 or 64-bit versions), 11 (64-bit only) is
supported for running applications

Java application servers Tomcat 9.0.x

JBoss EAP 7.1.x (where x>=4 for JCA), and 7.2.x

Oracle WebLogic 12.2.1

IBM WebSphere 9.0 and Liberty 19.0.0.x (where x >=12
for JVM COBOL)

Relational databases Oracle 18c and 19c

SQL Server 2014, 2016, 2017, and 2019

DB2 LUW 10.5, 11.1, and 11.5

EDB PostgreSQL 10.x (where x>=5), and 11.x

MySQL 5.7

Middleware Oracle Tuxedo and Tuxedo ART 12.1.3c

IBM TXSeries for Multiplatforms 9.1

IBM WebSphere MQ 8.0

Platform support See http://supportline.microfocus.com/prodavail.aspx

* See Installing Visual COBOL into other instances of Eclipse in your Product Help.

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.

Installation | 51

http://supportline.microfocus.com/prodavail.aspx
https://sld.microfocus.com/mysoftware/download/downloadcenter
https://sld.microfocus.com/mysoftware/download/downloadcenter


4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows
System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL

2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit
Windows, the setup file does not install some of the components. See Issues with the Installation in
Known Issues and Restrictions.

You can produce both 64-bit and 32-bit applications with Visual COBOL on 64-bit operating systems.

• Support for development and deployment on Windows 7 has been discontinued.
• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These

platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.
• Visual COBOL Build Tools for Windows x64 is only supported on Windows 10 or Windows Server 2019

operating systems.
• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 1.1.1k-mf6 (modified).

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit
Windows, the setup file does not install some of the components. See Issues with the Installation in
Known Issues and Restrictions.
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• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.16 (2020-06).
• The installation requires Java v11 or later such as AdoptOpenJDK 11. If not found on the machine, the

setup file will install AdoptOpenJDK 11 (LTS).
• Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both

32-bit and 64-bit applications.
• The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.

Requirements for running the product

• Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 11 (LTS) with HotSpot, which the Windows product installs automatically.
You can download AdoptOpenJDK's OpenJDK 11 (LTS) with HotSpot from AdoptOpenJDK's Web site
and unpack the archive anywhere on your machine.

• Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:
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• Visual COBOL and Enterprise Developer cannot coexist on the same machine.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

• If you already have Microsoft Build Tools for Visual Studio 2017 installed, you must ensure that it
contains the Visual C++ build tools workload (or at least the individual components contained in that
workload) before you run this installation.

On UNIX
System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 1.11 GB 4.42 GB 2.21 GB 50 MB

x64 running
SUSE SLES

Micro Focus 924 MB 3.70 GB 1.85 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On SUSE 12 and 15 you can only install and use the 64-bit version of this product. You can still produce
both 64-bit and 32-bit applications on 64-bit operating systems.

Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• Software installed by the setup file
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• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java v11 or later such as AdoptOpenJDK 11 (LTS) with HotSpot or later.
• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.
• The pax archiving utility. Pax is distributed with most UNIX and Linux systems but, if it is missing, you

must install it separately. To verify pax is installed, run pax --help or pax --version at the command line.

On Red Hat 8.1, pax is no longer installed by default. You must install the spax version found in the OS
ISO. Use the yum install spax command.

• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use
Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 CentOS 8.2 Ubuntu
20.4

glibc2 X X X X

libgcc X X X X

libgc1c2 X X

libstdc++ X X X X

glibc-locale3 X X X X

libXtst6 X X X X

libXtst X X X X

glibc-devel X X X X

gtk3 X X7 X7 X

PackageKit-
gtk3

X X7 X7 X

libcanberra-
gtk3

X X7 X7 X

webkitgtk3 X X7

webkit2gtk3 X X7 X

xterm Any
versi
on

Any
versi
on

X X X X
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Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 CentOS 8.2 Ubuntu
20.4

unzip Any
versi
on

Any
versi
on

X X X X

libgnome X X

libgtk-3-0 X X7 X7 X

gtk3-tools X X7 X7

gcc45 X X X X X X

cpp4 X X X

libnotify-
tools6

X X X X

libnotify X X

libjasper1 X X X

libjasper4 X X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 or 15, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit

library is still required by the SafeNet licensing components.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• 2The glibc-locale-32bit library is only required if you want to install the SafeNet licensing

components. If this is present, the installer installs and configures both SafeNet and AutoPass
licensing. If glibc-locale-32bit is not installed, the installer only installs AutoPass licensing.

• 3On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 4On Red Hat, these libraries are required to enable COBOL to compile.
• 5On Red Hat, only the 64-bit gcc libraries are required.
• 6For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Visual COBOL
for Eclipse from a desktop icon. Execute the following command to install the libnotify-tools library:
zypper install libnotify-tools

• 7The minimum GTK support required is 3.20. Certain platforms meet this requirement without the
need of installing the libraries manually; for example Red Hat 7.4 and SUSE 12 SP3.

Required environment variables

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:
export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH
• You need to set the LANG environment variable to pick up localized messages. If you do not set it as

specified here, the installation will run but you might experience unexpected behavior from the installer.
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The LANG settings are English and Japanese only so set it to one of the following locales:
C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:
export LANG=C

Alternatively, add it to the start of the setup command line:
LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

Software installed by the setup file
• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.16 (2020-06). After the

installation, you can install Visual COBOL as a plug-in into other Eclipse 4.16 (2020-06) instances
available on the same machine - see Installing Visual COBOL into other instances of Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product
• Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is

AdoptOpenJDK's OpenJDK 11 (LTS) with HotSpot, which the Windows product installs automatically.
You can download AdoptOpenJDK's OpenJDK 11 (LTS) with HotSpot from AdoptOpenJDK's Web site
and unpack the archive anywhere on your machine.

License Manager requirements
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Issues with the Installation on UNIX and Linux
• If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without

loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
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able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For

example, untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Visual COBOL.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:
error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -ESadminID=[User
ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

On Windows
Installing on Windows

Note:

• This version of the product is a full install.
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• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an
Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:

1. Run the vce_70.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual COBOL folder
and installs a full version of Eclipse 4.16 (2020-06) 64-bit, with the Micro Focus plugins already
installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

On UNIX
Installing the software
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_deveclipse_7.0_platform

2. Run the setup file with superuser permissions:
./setup_visualcobol_deveclipse_7.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A full
version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/eclipse
directory.

To install in a different location use the -installlocation="Location" parameter to specify an alternative
directory location. For example:
./setup_visualcobol_deveclipse_7.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For example,
the following examples are equivalent:
-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
. /setup_visualcobol_deveclipse_7.0_platform -skipsafenet
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• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command line option:
cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:
./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:
touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command line option:
cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Setting up the environment
If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

Note: The default directory is /opt/microfocus/Visual COBOL/.

1. To set up your product, execute:
. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:
cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product
To start Eclipse:

• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh
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• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:
eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing into other instances of Eclipse - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care

See this information on the Product Documentation pages on Micro Focus Customer Care - for Windows 
click here and for UNIX click here.

On Windows
Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any Patch Updates of the older version of
the product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can restore the
Enterprise Server configuration after installing this release - click Import on the Enterprise Server
Administration home page.

Visual COBOL Installation Options
To see what parameters you can use, execute the following from the command line:
install-file /help

where install-file for the following products is as follows:

Visual COBOL vce_70.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.

• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the path
and file name, for example:
/log drive:\path\LogFilename
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Skipping installation of the Microsoft package dependencies

A standard installation downloads and installs the latest versions of the Microsoft Build Tools (for Visual
Studio 2017) and the Windows 10 SDK packages to their default locations. Using the following option, you
can skip installation of these packages, thus reducing the footprint and duration of the installation. See
Microsoft Package Dependencies to see if you can safely skip installing these packages.
vce_70.exe skipmstools=1 

Offline installations

An offline installation is one where the client running an install is not connected to the internet; the problem
this presents is that the installer cannot download and install certain file and package dependencies; see
Microsoft Package Dependencies. In such circumstances, an administrator (or at least someone connected
to the internet) must download and make any dependencies available on the local network beforehand.

To prepare an offline installation, the administrator should run their own (online) installation using the
downloadmstools parameter: this downloads the package dependencies to <directory>, which should be a
fully-qualified path to a location accessible to the client when they run an installation.
start /wait vce_70.exe /q downloadmstools=<directory>

A client can then run an offline installation by pointing their installer at the location of the packages:
vce_70.exe installmstools=<directory>

This command runs a full product install; during which it uses the locally-accessible <directory> to install
the package dependencies.

Installing silently
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which features to
install. You must execute the command with superuser permissions.

start /wait install-file.exe /q [parameters]

Examples

• To silently install Visual COBOL into a directory other than the default:
start /wait vce_70.exe /q InstallFolder=c:\DirectoryName

• If you want to silently install the Eclipse IDE in a location other than the default, execute:
start /wait vce_70.exe /q InstallFolder2=c:\EclipseInstallDirectory

Microsoft Package Dependencies
Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following packages: the Windows SDK package and the Microsoft Build Tools
package.

There is a dependency on the Microsoft Windows SDK if you:

• Produce COBOL .exe or .dll files.
• Call Windows APIs from your COBOL .exe or .dll files.
• Link a C object file into a COBOL .exe or .dll file.
• Call Windows APIs from a C object file linked into a COBOL .exe or .dll file.
• Create MIDL files for OLE RPC.

There is a dependency on the Microsoft Build Tools if you:

• Produce COBOL .exe or .dll files.
• Manage .lib files.
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• Convert resource files to object modules.

A standard installation downloads and installs the latest available versions of the Windows 10 SDK and the
Microsoft Build Tools for Visual Studio 2017 to a default location.

If you distribute a COBOL product installation to clients that do not have access to the internet, then you
need to have downloaded these packages and placed them in an accessible place on the network before
clients can run an 'offline installation'. The installer includes options to achieve this: downloadmstools
enables you to download the required packages to a specific location; and installmstools enables an offline
client to install the packages from a local network location.

If you do not use any of the features described above, you can use an install parameter (skipmstools=1)
that will skip the download and installation of these dependencies.

All of these installation options are discussed in more detail in the Installation Options topic for your
product.

One of the final steps of the installation process configures the downloaded and installed package versions
for use in your COBOL environment. You can view these versions using the Microsoft Build Tools and
Windows SDK Configuration Utility - see Managing the Microsoft Build Tools and Windows SDK Packages.
This utility also enables you to specify alternative versions should you need to depend on a specific
package other than the one downloaded, or one stored in a non-default location.

On UNIX
Installing as an upgrade
This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL installer with the –installlocation option:

1. Execute the following command:
. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL_eclipse"

Note: You can use variables when specifying an absolute path for –installlocation. For example,
the following examples are equivalent:
-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving the MFDS and Enterprise Server region configuration

The following information applies when you are upgrading from release 6.0.

If you install this release to the same install location as release 6.0, the product in the current location is
moved to a backup directory name.

For example, if the 6.0 product is installed in the default install location, /opt/microfocus/VisualCOBOL,
during the upgrade it is moved to /opt/microfocus/VisualCOBOL.BKP.YYYY-MM-DD.HH:MM:SS. The new
release will be installed in /opt/microfocus/VisualCOBOL.

Note that your original installation might include some files that you changed or added to, and you need
those changes preserved in the new installation.
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During the upgrade, the installer moves a number of changed files to a different configuration location and
symbolically links them back into the new release install location. The configuration location is one of the
following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using the sum of the value of the $COBDIR
path. This is so that each configuration area is unique to each product installation. The configuration files
and directories are then placed in this COBDIR hash-numbered directory. In the examples below, the install
location generates a hash of 12345.

The file /opt/microfocus/config/12345/COBDIRlocation.txt details the COBDIR the configuration area is
associated with.

Currently, the setup file only moves the following files and directories:

Source Destination

secrets /opt/microfocus/config/12345/secrets/

commonwebadmin.json /opt/microfocus/config/12345/escwa/
commonwebadmin.json

mfdsacfg.xml /opt/microfocus/config/12345/mfds/mfdsacfg.xml

mfds /opt/microfocus/config/12345/mfds/mfds/

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/VisualCOBOL.BKP.YYYY-MM-DD.HH:MM:SS, into the install location
after the upgrade installation is complete.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an alternative
directory location. For example:
./setup_visualcobol_deveclipse_7.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For example, the
following examples are equivalent:
-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Skip Java Check

To skip the Java version check, use the -skipjavachk option. This skips the parts of the installation that
require Java, for example, the Eclipse installation. This can be used when you do not have Java on your
path and want to perform a custom installation. You can then manually configure the plug-ins as required:
./setup_visualcobol_deveclipse_7.0_platform -skipjavachk
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Skip Installing Eclipse

To skip the installation of Eclipse, use the -skipeclipse option. This enables you to install Visual COBOL
into your own version of Eclipse.
./setup_visualcobol_deveclipse_7.0_platform -skipeclipse

Note: You need to install the COBOL plug-ins manually.

Installing into a 32-bit Version of Eclipse

To skip the installation of the shipped Eclipse version but still install the plug-ins, use the -32bit option. This
enables you to install your own 32-bit version of Eclipse and manually install the required Visual COBOL
components.
./setup_visualcobol_deveclipse_7.0_platform -32bit

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ] [ -
ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:
–silent -IacceptEULA

For example, execute:
setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any updates to the documentation which might have been uploaded.

On Windows
Configuring Visual COBOL
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
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1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Managing the Microsoft Build Tools and Windows SDK Packages
There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.

The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:
-U

Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
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Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by Customer Care.)

-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.
cblms -USDK:C:\WinSDK\10\10.0.17134.0

Using an X Server on Windows
Some features of Visual COBOL for Eclipse on Windows require an X Server installation such as Micro
Focus Reflection Desktop for X or Micro Focus ViewNow X.

Micro Focus Reflection Desktop for X is provided as part of Visual COBOL. Find the Reflection Desktop for
X documentation on the Micro Focus SupportLine dropdown menu.
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Viewing the Product Help
Visual COBOL is configured to display the product help available online on the Micro Focus Customer
Care website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Visual COBOL product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Visual COBOL help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Visual COBOL help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro Focus-branded
documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing on Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

68 | Installation

https://www.microfocus.com/en-us/support/documentation/


Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
Focus License Administration. Uninstalling only Visual COBOL does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall

On UNIX
Configuring Visual COBOL
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on
UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:
$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Enabling SHIFT-JIS
By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.
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You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:
sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:
export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:
cobutf8 <command>

See your product documentation for more details about cobutf8.

Viewing the Product Help
Visual COBOL is configured to display the product help available online on the Micro Focus Customer
Care website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Visual COBOL product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Visual COBOL help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Visual COBOL help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro Focus-branded
documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

70 | Installation

https://www.microfocus.com/en-us/support/documentation/


1. Execute as root the Uninstall_VisualCOBOLEclipse7.0.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/microfocuslicensing/bin
directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid full license of Visual COBOL in order to continue using the product.

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus Customer Care.

To activate Visual COBOL Personal Edition
To activate Personal Edition:

1. Start Visual COBOL.

If you have not installed a license for Visual COBOL, starting the IDE for the first time after you install
the product opens the Micro Focus Visual COBOL Product Licensing dialog box. If you cancel this
dialog box, you can invoke it again from Help > Micro Focus > Product Licensing.

2. Copy the authorization code which you were sent after registering for Personal Edition, and paste it into
the Authorization code field.

3. Click Finish.

You should receive a message that the activation has been successful.
4. Restart Eclipse to complete the activation process.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus Customer Care.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows: To start the GUI Micro Focus License Administration

Windows 8.1, and Windows
Server 2012 R2

From the Windows Start screen, click the License Administration
tile.

Windows 10 and Later From your Windows desktop, click Start > Micro Focus License
Manager > License Administration.

Windows: To start the command-line Micro Focus License Administration tool
1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing
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2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension for Sentinel RMS licenses or an .xml extension for
AutoPass licenses) or an authorisation code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only). You need to install AutoPass licenses into the existing Micro Focus License
Administration tool, and not in the AutoPass License Server.

If you have a license file
Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic or .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of either .mflic or .xml), and then click Open.
6. Click Finish to install the license.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code
Note: Authorization codes are only available with Sentinel RMS licensing.
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Authorizing your product when you have an Internet connection
Note:

• This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus Customer Care Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
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6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

Windows: To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

UNIX

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.
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To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and

additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

https://www.microfocus.com/en-us/resource-center/webinar
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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Copyright and Disclaimer
© Copyright 2021 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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